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o We Need Some Data
‘ . —TeT =

Exit Program Options... Help

‘ GasTurb 13

— \ ( ‘v s - F——
@' Read Data for the Turbojet &’ . - (-5

‘ oy [ Select the engine
> @le . « GasTurbl3 » Data [ n P

Jet Engines | Gas Turbines | Propulsion | Power Generation | About |

i model
» Basic Thermodynamics o
Organisieren v Neuer Ordner g= ~» [ @
¥ Scope -
b S Favoriten Name Anderungsdatum
|¥'| Demo_jet.CYJ 10.08.2016 18:47
4 Bibliotheken |<| Demo_jet_reheat.CY) 10.08.2016 18:47
S > =] Bilder |<'| DemolStageRadComp.CY) 10.08.2016 18:47
= ) B
Performance || © [3 pokumente [ Demo25tageRadComp.CY) 10.08.2016 18:47 |
T > o) Musik 2] DemoAxRadComp.CY) 22.08.2016 1512
b 9 b (=l] Subversion BT
> E Videos l
i :
| % Computer
& - . \lirbofan B
! Open the engine
> € Netzwerk model
< | mn »
\ i
Dateiname: Demo_jet.CY) 4 [Cycle I'-73‘\ /ﬁes .Yy '] 1B
\
[ Offnen’ |v [ Abbrechen ]

Sz Bypam Mode

Engine Model

1 Sp Mixed Turbofan Variable Cycle Engine Ramjet
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o Off-Design Input Data Page

= ) 7
\ @' Off Design Input for a Turbojet M
Cycle Design  Main Window  Exit Program  Help
< = Basic Data Basic Data Distortion
Run an Off-Design\ —0ff Desigh Point ] Modifiers ] No
simulation without ¥ Task : {’;F“"l'e"'\tnCOEdglonsb Property Unit Value Comment
changes % alt,Mach; glam Intake Pressure Ratio 0,99
|i Iﬂ = OTLPL, Pamp Fuel Heating Value MJ/kg 43124
A : ] 4= Nozzle Calculation
0D Point | Operat Line Parametric i@ Standard Overboard Bleed kg/s 0
= : Rel. Overboard Bleed W_BId/W2 0,01
> ..®S CFG and CD = ?
= I 4 all - SRR R Recirculating Bleed W._reci/W2 0
Mission  Flight Envel Monte Carlo 4 7 Controls
L M Lo Power Offtake kW 0
M - Min Limiters : )
Q g ® - Max Limiters ZXN given (1) or ZT4 given (2) 1
Analysis  Sensitivity  Init Trans ...EPR Definition HPC Spool Speed ZXN 1
m . Var Geometry Compressor Delta VG Setting[deg 0 inactive
: b - Iteration Variables d_HPT Efficiency / d_XN 0
Batchjob ransient 5
» Maps and Connections
an
E
O
2
=
17}
2]
O
©
N
=
o0
g
E C:\Program Files (x86)\GasTurb13\Data\Demo_jet.CYJ (modified) Off Design Point
 eee—————————eeeeeeeeeeeeeeeeer
o
U :
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o Off-Design Point Summary

( )
~ ... | Havealockatthe .
@ SL static, ISA, compressor map | E‘M
Close Help §
Summary lOper.Fmi Compr I Turb I Air System I Stations‘
o =
! = %_.L W T P WRstd
Range  Saveinput  Slider Station kg/s K kpa kg/s FN = 26,37 kN
ﬁ amb 288,15 101,325 TSFC = 25,0985 g/(kN*s)
1 31,680 288,15 101,325 FN/W2 = 832,50 m/s
Unit Conv Title 2 31,680 288,15 100,312 32,000
< D 3 31,680 630,42 1203,741 3,944 Prop Eff = 0,0000
31 28.195 630,42 1203.741 eta core =  0.3884
4 28,857 1450,00 1167,629 5,617 P5/P2 = 3,6623 EPR
mom N 41 30,441 1411.20 1167.629 51846 WF = 0,66194 kg/s
TS H-S PV 49 30,441 1113,50 367,374 s NOx = 0,28659
5 32,025 1091,37 367,374 17,190 X8 = 1,0000
2% 6 32,025 1091,37 360,027 A8 = 0,0773 m?
e 8 32,025 1091,37 360,027 17,541 P8/Pamb =  3,5532
Bleed 0,317 630,42 1203,738 wBld/w2 = 0,01000
-------------------------------------------- Ang8' = 20,00 °
= £ P2/P1 = 0,9900 P4/P3 = 0,9700 P6/P5 0,9800 CD8 = 0,9600
H:ﬂ L[j [}? Efficiencies: isentr polytr RNI P/P WCIN/W2 = 0,05000
L i T Compressor 0,8500 0,8913 0,990 12,000 WC]R[WZ = 0,05000
e Burner 0,9999 0,970 Loading = 100,00 %
Excel Turbine 0,8900 0,8757 1,798 3,178 e45 th- = 0,87139
m -------------------------------------------- far7 =: 0702111
Spool mech Eff 0,9999 Speed 12499 rpm PWX = 0,00 kw
Initialize Export BRI e e ettt e e
hum [%] war0 FHV Fuel

0,0 0,00000 43,124 Generic

Input Data File:
C:QProgram Files (x86)\GasTurbl3\Data\Demo_jet.CY]

This is the cycle design point,
calculated in off-design mode.

Title:
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o Standard Compressor Map

- ’ .
@ SLstatic, ISA, Rel GG Speed=1.000 [E=NEER

| Summary | Oper.Point| Compr | Turb | Air System | Stations |

e e Compr The circle marks the cycle
Close the result = 16- design point, the yellow
window Ont ey e square marks the off-design

operating point.

m m K\- 14
& O &

®

Preferences Axes Station Data

- K

o~ 10
&
= = o
= [y [ o
Print Clipboard Save © 8
Excel o
EE 2
=
Initialize Export Disconnect 8 6
2
o
% Save 4-
g The cycle design point is
G) \ B In this spec| Mass Flow W2RStd = 32 kg/s
'g " N the cycle{ Pressure Ratio = 12
% W2RStd = Mass o yel Eff1c1ency = 0.85
8 Flow Corrected to . . _ . ' ' |
O Standard Day 1 16 20 24 28 ( 32) 36
= Conditions OG- Mass Flow W, [kg/s]
)
=g Titl:
o
o
@)
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o Off-Design Input Data Page

- . \
Off Design Input for a Turbojet &@Iﬂ
gn Inp )]

Cycle Design  Main Window  Exit Program  Help
¢ T - Basic Data Basic Data Distortion
> DeSIQn Point ! Modifiers =] No
¥ Task A-L:Amblent Conditions Property Unit Value Comment
= ° alt, Mach, dtamb Intake Pressure Ratio 0,99
L @ itonden o Fuel Heating Value Mikg 43124
0D Point | Operat Line Parametric 24 : Aozszt:n d:r((:iu o Overboard Bleed kg/s 0
= A Rel. Overboard Bleed W_BId/\W2 0,01
> P ©) Specify CFG and CD Yo = ;
Mission  Flight Envel Monte Carlo 4 75 Controls Eecmjcl;mg o el KW g
SEe - Min Limiters ower_ axe =
Q 4= ® L Mavc Lifmiters ZXN given (1) or ZT4 given (2) 1
Analysis  Sensitivity  Init Trans EPR Definition HPC Spool Speed ZXN 1
T\ ... Var Geometry Compressor Delta VG Setting[deg 0 inactive
S R "/ﬂ . - Iteration Variables d_HPT Efficiency / d_XN 0
gom vkl - Transient
» Project
» Additional
¥ Maps and Connections
. O 0 &
Click on Special to Special  Scaling
configure Special o F\
Maps ve Maps Intake Map
Fuel:
Generic -
=
&
'g The Standard Maps yield in many cases
= reasonable trends. However, for accurate
8 simulations the Standard Maps must be replaced
© by Special Maps.
N
=
2
; C:\Program Files (x86)\GasTurb13\Data\Demo_jet.CYJ (modified) Off Design Point
o
]
O
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o HP Compressor Map

‘ [ ®' Special Component Maps @Eﬂ‘
Close Help
Edit : X ! L Compr J [ Turbine ]
Mass flow units in map: Map lReynoIds‘
[Notanm v
|fRead from Fite: Y You can either edit the coordinates of the\
design point or move the design point with
=an (LPC) Maposter (IPC) MAxial HPC Ma the mouse: CIle |t, keep the button 74
G pressed, move it. /1
Compr Map A {
= . . .
A\ e E = We will set the cycle design point now to
‘“;Ti” — H:']“ Beta,ds = 0.4 N T
= N/sqrt(T),ds = 1.05 [ > e
Scal + Maps Axes
= @ At the yellow square the efficiency in the map
Scaling Preferences is 0.86015. g The ye”OW
S o To scale the map in such a way that it fits to square marks
PIP-1 Scaler 1506 o the cycle design point (n=0.85) the factors fn = A the cycle design
Eff Scaler 0,954 0 9884 and f =0 9998 are annlied- ) § point.
RN Flow Corr 0,9999 L. X i L. X > 4
RN Eff Corr 0,9998 Peak Efficiency is the highest efficiency found in|{.~ ¥ 7 o] E
Peak Eff 0,8568 . . . 2
Surge Margin 2613 The coordinates of the design point in the map |}~ i
E Beta ds 0,5 (the yellow square) are R
= s U L N Beta,ds = 0.5 and N/sqrt(T),ds = 1 ;
5 | | Y i S NS ———— X i !
I | | A AT SN S NG I X -------- o H
—URR Y ([ I N S B U % :
= = i
w2 i T T T T T y
Z ["1Do not Scale this Map 25 30 i 35
&) Mass Flow W H
© | 2RStd i |
- 0,25 0,3 0,35 04 0,45 0,5 0,55 0,6
o Compr Entry Mach Number
' E\ C:\Program Files (x86)\GasTurb13\HPC01.MAP The map is shown un-scaled and without Reynolds corrections
% 5
Q
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o Map Scaling

- , .
@' Special Component Maps E@g

7/Close Help
Edlt 5 ; y [ Compr ” Turbine X 2 ‘
Mass flow units in map: Map l Reynolds ‘
(benome 3] Entry Mach Number is a Design Calculation Input

Close the map

; ile: Compr
window Read from File: p
10, -
=an (LPC) Maposter (IPC) MAxial HPC Maj ’ "
Compr Map 94 A "' §

E"

HPTMap  IPT Map LPT Map é
r— “g 8 ’ /—/,.'
Scal + Maps Axes 3 L/
S| @ / At the yellow square the efficiency in the maf)\/'
Scaling Preferences is now 0.8246.

To scale the map in such a way that it fits to

&
Flow Scaler 0 Mﬂmﬁnﬁﬂuﬂﬂ.&aﬁ&:&fﬁ / i
i e 1  Peak Efficiency is the highest efficiency found 1.~ z
RN Flow Corr 0,9999 }l in the scaled map. Previously it was 0.8568, | . }%
RN Eff Corr 0,9998 e Nnoana e 1
T 08929 now |t' is 0.8929. . . ] -
Surge Margin 37,16 The reason for that is: the cycle design point -~ B
s Beta ds 0.4 0.85 - i
= Nisqrt(T) ds 1,05 \ . / !
E‘: ___________ s 4
R | —— A S P e v o ;
SO (O e g = % '
E — T 5
wn i T T T "
8 [7] Do not Scale this Map 25 30 35
Mass Flow W i
O | 2RStd ! |
=B 2 0,25 0,3 0,35 0,4 0,45 0,5 0,55 0
an Compr Entry Mach Number
; C:\Program Files (x86)\GasTurb13\HPC01.MAP The map is shown un-scaled and without Reynolds corrections
&
O
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o Save the data as Engine Model

‘ @ Off Design Input for a Turbojet ELM
Cycle Design  Main Window  Exit Program  Help
: E - Basic Data Basic Data Distortion
. . @fperatm Line : :
Click on Operating g ) -~ Modifiers - E_Ino
Line 1 @ at. Mac, damb Progery |yt _{Commert
‘ % _?_: PfCF; tzm Intake Pressure Ratio 0,99
3 211, P11, Pam "
Next we run a ) @ ) 4.7 Nozzle Calculation gteI:eazn; Vzlue kMJ//kg 33'124
single operating line ~ 2EerEtEne) Faremetne @ Standard proar. Tes B3
. Il JJJ.[L = Specify CFG and CD Rel. Overboard Bleed W_BId/W2 0,01
with the default | a== C>ﬁnt::7ls Recirculating Bleed W_reci/WW2 0
settings. b Elp- el Bndle (A T Power Offtake Kw 0
4= (©) S ——— ZXN given (1) or ZT4 given (2) 1
Analysis  Sensitivity  Init Trans EPR Definition HPC Spool Speed ZXN 1
) “..Var Geometry Compressor Delta VG Setting[deg 0 inactive
) e - Iteration Variables d_HPT Efficiency / d_XN 0
Batchjob ransient .
- Transient
’h Engine @
Read Model gye
Off-Design Point Input Data
= # |
Read File History Save
e - I
it il e The data can only be stored as Engine Model
% File if all data on the Steady State page are
= 2 Ekras : identical to those from the cycle design point
O and if all the Modifiers are zero.
o)
=
= An Engine Model File contains in addition to a
S normal data file information about the
© component maps and how they are scaled.
5
2
% C:\Program Files (x86)\GasTurb13\Data\Demo_jet.CYJ (modified) Operating Line
o
@)




Gafsf]'urb

o Off-Design Input Data Page

AR— e D@‘
Close Help / )
N [»D@erating Line ] Mﬁurﬂl ‘Y=f(X) \
[ Run the Operating T ¥ Manage 1'.—?3 Review] YA AN
Line J/ 855

¥ Gas Generator Speed St...

15 1 Points A
Incr NH
0.025 NH Stepsize ¢
Decr NH 7
» Thrust Steps

» Compare

» Compressor Map(s)

¥ v N
10 More operating lines 7
L S 4

Select No }
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Compressor Map New

7
@' Operating Line

Close Help

Turbine | Y=f(x)

(b Reven

¥ Clipboard, Print, Inspect
Copy to Clipboard

If we would use the Standard Map with

default setting of the cycle design point

[y I Oy (i.e. Beta,ds = 0.5 and N/sqgrt(T),ds = 1),
N e then the operating line in the compressor  [ficiency is the A
i map would look as in the next slide. st efficiency

the

the map, it is

____
e

Details
» Picture Catalog 12
» Picture Format
» Turbine Map(s)
0104
» to Excel and Text File =,
o
(=)
% 8
hd
)
e
» 61
» P
) A
— . A
& D s /
4 A AN
\ .70 =]
2 ™} 2 ¥ =
\"' o 2
‘Y
0,9;\6‘ =
0 -
4 8 12 16
Mass

design point has the relative corrected speed
value of 1.

The numbers at the other speed lines are
those from the un-scaled map, divided by
N/sqrt(T),ds = 1.05

]
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o Compressor Map Old

‘ f @' Operating Line @m‘
Close Help
Compr | Turbine | Y=f(x)
5 _—_
¥ Clipboard, Print, Inspect
Copy to Clipboard 161 y
] ‘—‘ . . ,’r“
[ -8 Peak Efficiency is the N
Overlay Color . . 1 H
A 144 highest efficiency i
= found in the map, i
Details s ,,I
> Plcture Catalog 2! here it is 0.8568. /)
]
» Picture Format
Turbine M.
» Turbine Map(s) 0_“ 101
» to Excel and Text File =
o
S ol 0 N S TN e
5 8 = 2
o o]
o L.
3 6 — 11— SN LS
SR
0_ £ oL A NAT
4 ALATON
an P S =X =
e} iz ~
O e = o - . .
o 0 o e speed line passing through the cycle
E ) design point has the relative corrected speed
0 " - -
2 A z " 6 value of 1.
O Mass Flow W, [kg/s]
©
N
=
oh
=
>
o
o
Q
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o Effect of Map Scaling on SFC

o

34 A
Hint:
This slide is made of two pictures which

304
were copied to the clipboard from GasTurb
and then pasted into Power Point.
29-
28 Standard Map Scaled With the Special Design
Point Coordinates
Beta,ds = 0.4 and N/sqrt(T),ds = 1.05
27

Standard Map Scaled With the Default Design
Point Coordinates
Beta,ds = 0.5 and N/sqrt(T),ds = 1

Sp. Fuel Consumption [g/(kN*s}]

25
< 24
g
O
o) 23] This is the cycle design
[ I
= \3\'}_ __D/C'/ point where both
4 —— operating lines agree.
O 22 . . . . . ; ; 4
© 0 4 8 12 16 20 24 28 32
= Net Thrust [kN]
o
Y
5)
Q
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‘. Comparing Measured Data With GasTurb
@

»
@' Off Design Input for a Turbojet li@lg
Cycle Design  Main Window  Exit Program Help
: E Basic Data Basic Data Distortion
perating Line ! : |
And run another 1 s Mo::ii)rizm Conditions e
Operating line J/ ¥ Task - = Property Unit Value Comment
P 9 - -® alt, Mach, dtamb Intake Pressure Ratio 0,99
li @ g BT3P, F’amp Fuel Heating Value MJ/kg 43124
) : ) 4= Nozzle Calculation
OD Point | Operat Line| Parametric  Staridaid Overboard Bleed kg/s 0
: : Rel. Overboard Bleed W_BId/W2 0,01
> @) = ;
= | 4 all - =@ ey CEGnd LD Recirculating Bleed W _reci/W2 0
Mission  Flight Envel Monte Carlo 4 7 Controls P Oftak W 0
L - Min Limiters ower_ axe =
Q 4= @ ‘.. Max Limiters ZXN given (1) or ZT4 given (2) 1
Analysis  Sensitivity  Init Trans .EPR Definition HPC Spool Speed ZXN 1
' ‘. Var Geometry Compressor Delta VG Setting[deg 0 inactive
; ok - . lteration Variables d_HPT Efficiency / d_XN 0
Batchjob ransient j
- Transient
K 5
Switch back to TG
=]
Standard maps J/ E‘:
Save Maps Intake Map
Fuel:
Generic -
=
E
O
2
=
1}
<
O
©
N
=
. EO .|
; C:\Program Files (x86)\GasTurb13\Data\Demo_jet.CYJ (modified) Operating Line
o
o
Q
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@
[

Read Test Data

.
@' Operating Line

Close Help

- \/,rl Operating Line Compr | Turbine | Y=f(x) ’
Run the Operating » P k 9 il e o
Line ¥ Manage Hzf—\Review
™) Stop
& orner Read the fil =
15 = Points ¢ @uvl |, « AppData » Roaming » Gag demo_]et.tst ) ",H DemoData durchsuchen ,D'
Incr NH
Lt Organisieren v Neuer Ordner V =~ [ @
0.025 NH Stepsize * e ! ‘ {erungsdatum Typ
Decr NH b 3¢ Favori
: ,‘T:;"‘B’f;:'
> =/ Bild¢ 7 2
r [— > E] Dok Iml
N\
Read a file with < Read Show Clear > @) Mus
measured data J/ b & Subr PN
Enrich e > B Vide |0i More operating lines ?
| ]
. = (2R Comp
b Select No
| T
| Test Data Files (*.st) ~|
r Offnen |v] [ Abbrechen ]
Click Open

Copyright © GasTurb GmbH
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@ Making the Comparative Data Visible

| r
‘ & Opering e =
Close Help
Y=fix)

k Review A Check Show Test
v Clipboard, Print, Inspect [ Click Plot ] Data
Copy to Clipboard =
.’ Y Axes
OV e Draw y=f(x) 1% Sp. Fuel Consumption [g/(kN"s)] Show Test Data Yes
( Group 5] 21 sort 2
Details »-Miscellaneous e
= »-Mass Flows W
» Picture Catal -
log »-Pressures P 1274
» Picture Format > Temperatures T =
» Turbine Map(s) :.;-Com.pressor(s) E5EE
> Turbine(s) 3
» to Excel and Text File 5-No Dimensions £ 1D
-With Dimensions (except W.P.T) gmz 5
> Thermodynamic Stations &
i - Iteration Variables 1212
127115
121
092 0.9 1 1,04 1.0 112 116 12

Net Thrust [kN]

Copyright © GasTurb GmbH
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~

Comparing SFC

-
@' Operating Line

Close Help

Click on New Picture
and plot the isentropic
compressor efficiency
over the corrected
compressor flow )

o] New Picture

I

Details
» Picture Catalog

¥ Manage| [% Review
¥ Clipboard, Print, Inspect
Copy to Clipboard

Oy OB

Overlay Color

(3

» Picture Format

» Turbine Map(s)
» to Excel and Text File

|\ SFC=f(FN) /
31;

30 %
291
281
271
261

251

Sp. Fuel Consumption [g/(kN*s)]

Compr | Turbine | Y=f(x) ‘

@ Test Data

Simulation

24 .
(o]
234 Q
(]

* Measured data

22 " - - -
4 12 16 20 24
Net Thrust [KN]

28
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S Comparing Compressor Efficiency

‘ fi @' Operating Line Lilm‘
Close Help
lENew PictNe I ﬁComprlTurbine Y=f(x) ‘
T —— mmw| ' e23is=f(W2Rstd) /, SFC=F(FN) /, /, 4 A A A A4S
0,88, =
@ TestData
¥ Gas Generator Speed St...
15~ Points ‘N
Incr NH 0,86-
0.025 NH Stepsize ¢
L Decr NH
i
-
£
B ; w
LPC Map IPC Map HPA Map g- 0,821
il EL Edit 3
. . —— &)
Click on Edit 1T compr Map &
Compr Map J/ o
2 084
LPC Map IPC Map HPA Map
Q Save
m Compr Map
,.g 0,781
% Measured compressor efficiency is higher
© than in the simulation. For improving the
= - agreement we go for editing the HPC Map.
o "125 15 175 vii) 775 75 775 30 325
g HPC Corrected Flow [kg/s]
N
<
ah
g
> |
o —
S)
@)
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Wz g3 The Compressor Map Editor

‘ [ @' Modify Efficiency and Re-label the Speed Lines Compr Lﬂlﬂ‘
- l Close Reset Help
Click on Speed to

Speed - Flow | Speed - Pressure Ratio

modify the Orig Speed  Peak Eff | Detta PEFT compr ——————— 7
speed-mass flow G50, Lobe6h, _jote2 |move | Alternatively to usin
Correlation 0,6000 0,7412 0,0714 move - Peak effici - y g
07000 07945 00535  move the slider you could
D300, 0,8169 g 00446, | move | edit the peak efficiency
0,8000 0,8387 0,0357 move I . thS COl mn
0,8500 0,8501 0,0268 move | ‘_’-0—375—’( values in tni u
0,9000 0,8566 0,0178 move | z
0,9500 0,8568 0,0089 move [
1,0000 0,8504 0 fix v
1,0500 0,8371 -0,0089 move [ > 0’85
[&]
&
'S 0,825
=
w
g 08
£
(o]
O
s 0,775
% =
(V]
R
» 075
(57
~ o
(]
0,725 o
=
£
(@) 0,7 pr
2
= 0,675
< 0,4 0,5 0,6 0,7 0,8 0,9 1 15
O XNRSTD Rel. Corr. Spool Speed
©
N
<
)
g
>
o
o
@)
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The new

should be saved
after closing the
map editor

compressor map

J

The Compressor Map Editor

@' Modify Efficiency and Re-label the Speed Lines Compr

Close

Reset Help

Efficiency SPee'g - Flow | Speed - Pressure Ratio

Speed
0,5000
0,6000
0,7000
0,7500
0,8000
0,8500
0,000
0,9500
1,0000
1,0500

D peed
-0,2400
-0,1920
-0,1440
-0,1200
-0,0960
-0,0720
-0,0480
-0,0240
0
0,0240

move
move
move
move
move
move
move
move
fix

move

Compr

W2Rstd HPC Corrected Flow

40,

CY

S8

Lo

Similarly we can affect the Speed-Mass
Flow correlation by re-labeling the speed
lines in the map.

05

06

.

XNRSTD Rel. Corr. Spool Speed




GasTurk The Simulation Agrees
e

with the Measurements

‘ f @' Operating Line @m‘
Close Help
IE New Picture ‘ Compr | Turbine | Y=Tix) |
y Clipboard, Print, Inspect 0,87
Copy to Clipboard ® TestData
D M @
Overlay Color
0,86
(5
Details
» Picture Catalog
» Picture Format 2 0,85
» Turbine Map(s) =
» to Excel and Text File é
uw
S 0,84 o
£
o
Q °
I=
[«}]
£ 0,83
@
—% 0,82
g b After some experiments with editing the
o map we get a reasonable line-up between
= a5 the measured data and the simulation.
o s 16 18 o 77 743 70 75 30 32
©) HPC Corrected Flow [kg/s]
©
N
=
oh
=
>
o
o
Q

This slide ends the
Component Maps
Tutorial



